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Pour votre sécurité

A AVERTISSENENT

Une mauvais

ces instructions.

tilisation peut étre a l'origine d'une

explosion, d'un incendie ou d'une décharge électrique.

Ne prenez pas l'initiative
de démonter, réparer ou
modifier cet appareil
vous-méme.

Ne mouillez pas I'appareil

AL et ne le laissez pas tomber
K
Yy dans I'eau.

Si l'appareil est mouillé, ne
l'allumez pas. Contactez un
centre de dépannage.

3 Ne posez pas |'appareil
dans un endroit humide,
poussiéreux ou couvert de
suie, sous peine de
provoquer un incendie ou
une décharge électrique.

Ne laissez pas |'appareil
dans un lieu ot la
température excéde 35°C
(ex.: sauna ou voiture en
stationnement).

En été, la température a
l'intérieur d'une voiture peut
atteindre 80°C.

<)

Lisez attentivement ce manuel afin d'utiliser cet appareil
correctement et d'éviter tout danger ou dommage matériel.

Vous risquez de vous blesser gravement si vous ne tenez pas compte de

Pour éviter les troubles auditifs

L'utilisation prolongée de I'écouteur ou du casque
peut fortement réduire votre acuité auditive.

Si vous vous exposez & un volume sonore
supérieur a 85 dB pendant une durée prolongée,
votre ouie sera irrémédiablement endommagée.
Plus le son est élevé, plus votre acuité auditive
diminue (une conversation ordinaire a un niveau
sonore compris entre 50 et 60 dB alors que celui
provenant d'une route est d'environ 80 dB).

Il est fortement recommandé d'utiliser un volume
sonore moyen (le volume moyen est habituellement
inférieur de 2/3 au volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus
I'écouteur ou le casque.

Pour éviter tout risque d'acci e laroute

Nutilisez pas I'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.
Dans le cas contraire, vous risqueriez de provoguer un
accident grave. En outre, son utilisation est interdite par la
loi dans certaines régions. L'utilisation de I'écouteur dans la
rue, particuliérement sur les passages pour piétons,
pourrait entrainer des accidents graves.

Pour votre propre sécurité, assurez-vous que le cable de
I'écouteur n’entrave pas vos mouvements ou ne s'ac-
croche pas dans des objets environnants lorsque vous
faites de I'exercice ou lorsque vous vous promenez.



Suivez attentivement ces instructions sous peine de provoquer des blessures physiques
A ATTENT|ON ou d'endommager I'appareil.

Utilisation de I'appareil
Gestion des données importantes Evitez de causer des dysfonctionnements

Veillez a toujours
enregistrer vos données les
plus importantes

Notez bien que nous ne saurons
étre tenus responsables en cas de
perte des données due a une
panne, & une réparation ou a toute
autre cause.

Evitez de causer des dysfonctionnements
)
(]

T3
: . 2
Evitez tout impact brutal
sur I'appareil (ex. : en
cas de chute). Ne posez pas
d'objets lourds sur le
dessus de l'appareil.
Empéchez que des ';;?

particules externes ou de
la poussiére ne pénetrent
dans I'appareil.
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Utilisez toujours les
accessoires fournis ou
agréés par Samsung.

Evitez toute projection d’eau
sur I'appareil. Ne nettoyez
jamais I'appareil a I'aide de
produits chimiques

(ex. : benzene ou diluant) sous
peine de provoquer un
incendie, une décharge
électrique ou une détérioration
de la surface.

Ne posez jamais I'appareil &
proximité d'objets émettant des
ondes électromagnétiques sous
peine de provoquer un
dysfonctionnement.
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Renseignements fondamentaux

Composants

| Vérification des accessoires

Lecteur Ecouteurs Cable USB CD d'installation

» L'aspect des accessoires est susceptible d'étre amélioré et modifié, sans notification préalable.



| Vue de face, cété droit

Tous les boutons sont de type ‘a effleurement’.

Affichage a I'écran

Bouton Menu

Bouton de retour
en arriére

Bouton «™ € ¥

Bouton Lecture/Pause
et Sélectionner

O JIREON | L
- \_,L\ & :

/—.4) Y

") AN =

T |/' L)

Interrupteur
Alimentation
et Maintien
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Renseignements fondamentaux

Composants (suite)

| Dessous/arriere

=7 —»> Port USB

e (—

Ecouteurs

[Dessous] R
[arriére] M
Trou de
réinitialisation

Branchement des écouteurs R PP PP PP PP P PP PTPPPPPPISPPPPPRI TS

» Dessous
N

Ecouteurs



Renseignements fondamentaux

Affichage des informations a I'écran

| Music (Musique)

~oR, Normal

1.Lifeis cool

002/020 > 00:02:20

Affichage du mode Play (Lecture)
Egaliseur graphique
Renseignements sur la musique
Barre d'état Play (Lecture)
Affichage du numéro de la piste en
cours/du nombre total de pistes

Affichage de l'effet sonore
Affichage de I'état de la batterie
Témoin de durée de lecture
Affichage de I'état Lecture/Pause

O wWNE
© 0w ~NO®

= Les représentations a I'écran figurent a titre indicatif uniquement. L'écran réel de votre appareil peut
RERQE étre différent.




Renseignements fondamentaux

Fonctions des boutons

Fonctions et utilisation

Faites glisser dans le sens opposé a celui indiqué par la fleche pour
allumer/éteindre I'appareil.
Faites glisser dans le sens indiqué par la fleche pour verrouiller les boutons.

o[ [Hows>] |

Appuyez longuement sur le bouton pour accéder a I'écran de menu.
Appuyez brievement sur le bouton pour revenir a I'écran précédent.

@)

Déplacement vers le haut, le bas, la gauche et la droite et sélection des
fonctions

Appuyez pour vous déplacer d’une sélection vers le haut ou vers le bas.

Appuyez pour vous déplacer d'une sélection vers la droite ou vers le

gauche.

Appuyez longuement pour vous déplacer continuellement vers le

haut ou vers le bas.

i © Appuyez brievement pour sélectionner lecture/pause et la

fonction de déplacement sur I'écran suivant.

4 Recherchez une piste et controlez le volume tout en écoutant la musique.
& Appuyez longuement sur le bouton pour balayer vers un point de la

piste en cours.

Appuyez brievement pour revenir a la piste précédente ou lire la

piste en cours a partir du début.

Appuyez longuement sur le bouton pour balayer vers un point de la

piste en cours.

Appuyez légérement dessus pour aller a la plage suivante.

" Appuyez sur le bouton pour diminuer/augmenter le volume.

B8] = Appuyez pour afficher le menu des options.



0 Tapez légerement avec
votre doigt.

ATTENTION

= Nutilisez pas d'objet tranchant pour actionner le pavé tactile.
Vous risqueriez de I'endommager.

= Veillez a garder les mains propres lorsque vous souhaitez utiliser le pavé tactile.

= Ne gardez pas vos gants lorsque vous appuyez légerement sur I'écran tactile. Le bouton risquerait de ne
pas fonctionner.

FRA
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Renseignements fondamentaux
H Chargez la batterie complétement avant d'utiliser le
Ch arg em ent d e | a b atter I e lecteur pour la premiére fois ou lorsqu'il n'a pas été

utilisé depuis longtemps.

1 Branchez le cable USB sur le port
USB ( !1/ )de votre ordinateur.

2 Branchez I'autre extrémité du cable
USB sur le fiche USB situé dans la
partie inférieure du lecteur.
= Une fois le lecteur branché a l'aide du cable

USB, le temps nécessaire a un chargement
complet est d'environ quatre heures ; ce
temps est susceptible de varier en fonction de
I'environnement installé sur I'ordinateur.

| utilisation de la batterie

Rechargez et rangez I'appareil dans un lieu ou la
température est comprise entre 5°C et 35°C.

Evitez de surcharger la batterie (12 heures au
maximum). Charger ou décharger la batterie a
des fréquences trop rapprochées peut réduire sa
durée de vie.

Comme pour tout autre produit de consommation,
la durée de vie de la batterie raccourcit
progressivement avec le temps.

Q « Vérifiez si la pile de I'ordinateur bloc-notes est completement chargée et utilisez le cable USB
pour charger le produit. Si la charge de la pile du bloc-notes n’est pas suffisante, n'utilisez pas le

REVARQUE K
cable USB pour la charger.




Renseignements fondamentaux

Utilisation de base

| Mise sous et hors tension de I'appareil

FRA

su5. Normal Mise sous tension de l'appareil

Appuyez longuement sur I'interrupteur [HOLD »] dans la
direction opposée a la fleche.

» L'appareil s'allume.

Mise hors tension de I'appareil

fREe Appuyez de nouveau longuement sur I'interrupteur [HOLD »]
w2020 dans la direction opposée a la fleche.

= L'appareil s'éteint.

Q = L'appareil s'éteint automatiquement lorsque aucun des boutons n'est actionné pendant une
RENARQLE durée prédéfinie (par défaut : 1 minute) en mode Pause (Pause). » Page 42

| Lire des fichiers musicaux

su8. Normal an 1 Appuyez longuement sur le bouton [ '] pour vous
déplacer vers le menu principal.

2 Appuyez sur le bouton [ < *] pour sélectionner <Music>

(Musique), puis appuyez sur le bouton [(D].
= Le menu Music (Musique) apparait.

1Lifeis cool

3 Utilisez les boutons [« =] et [ )] pour sélectionner un fichier
musical de votre choix.

0020020

Appuyez sur le bouton [ O)].
= La lecture du fichier musical est lancé.

= Appuyez brievement sur le bouton [ ® ] pour revenir & 'écran précédent.
RENARQUE = Appuyez longuement sur le bouton [ 2 ] pour vous déplacer vers le menu principal. 13
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Renseignements fondamentaux

Utilisation de base (suite)

| Réglage du volume

R Rl “|  Appuyez sur le bouton [« = ].
= Licone du contréle de volume s'affiche.

= Appuyez sur le bouton [ « | pour augmenter le volume ou sur le bouton [ = ]
pour le diminuer.

1Lifeis cool

0021020

| Fonction Lock (Verrouillage)

son. Normal “| En mode Hold, tous les boutons sont désactivés. Vous apprécierez
particulierement le coté pratique de cette fonction lors de vos
marches ou de vos courses a pied.

1 Poussez I'interrupteur [ HOLD »] dans le sens de la fleche.

2 Poussez l'interrupteur [ HOLD »] dans le sens opposé a celui
indiqué par la fleche pour désactiver la fonction Lock
(Verrouillage).




| Fonction Reset (Réinitialisation)

RESET

Trou de
réinitialisation

Si un dysfonctionnement de I'appareil
survient, vous pouvez réinitialiser le systeme
en appuyant sur le Trou de réinitialisation.

Appuyez sur le Trou de réinitialisation

situé sur la partie inférieure de I'appareil

al'aide d'un objet pointu, comme une

agrafe.

= Le systeme est réinitialisé.

= La fonction Reset (Réinitialisation) ne permet
pas de supprimer les renseignements de
durée et les données enregistrées dans la
mémoire intégrée.

FRA
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Ch td tre fichier f i
argement ge votre fichier favori Utilisez Media Studio pour

Installation de Media Studio de Samsung anstere ces iciers

musicaux de votre ordinateur
vers le lecteur.

Si Media Studio ne s'installe pas automatiquement
ATTENTION = Installez le programme sur un ordinateur fonctionnant sous Windows XP apres vous étre connecté
en tant qu'administrateur. Veuillez vous reporter au manuel d'utilisation de
I'ordinateur pour savoir comment vous connecter en tant qu'administrateur.

AL EpE Sy Insérez le CD diinstallation fourni avec le lecteur dans le lecteur de CD-ROM
de votre ordinateur.

% Install now
V

=+ Install now

Player 1 Cliquez sur <Install now> (Installer maintenant).

= User Manual
x Exit

InstaliShield Wizard X

2 Cliquez sur <NEXT> (SUIVANT).
ﬁi@fﬁ[‘%@%ﬁﬁﬂi‘a"s”W‘"E“’““”"‘““3‘"9‘“ = Linstallation de Media Studio est lancée.

TOM] to instal sfter setupinstallation settings or oick.
[EXT] to stat copying fles with the curert seltings.

= Une fois l'installation terminée, un £ icone
2 apparait sur le bureau et Media Studio démarre.

Installation Type =
Quik Instal: Select o instal the Samstung Media Stud

Curent Settings:

Installaton Information
Folder 1o Irstall: D\ Program FilstSamsungS smsung
Progiam Folder Samsung Media Studo 5

Gracenate Tems of Use

>




Chargement de votre fichier favori

Branchement de I'appareil sur un ordinateur

Utilisez le cable USB fourni pour brancher I'appareil sur l'ordinateur.

1

1 Branchez le cable USB sur le port USB ( ‘I}) de votre ordinateur.

FRA

2 Branchez I'autre extrémité du cable USB sur le fiche USB situé dans la partie
inférieure du lecteur.

| Configuration requise

Votre systéme d’ordinateur doit satisfaire les caractéristiques suivantes :

« Pentium 300 MHz ou plus = Windows XP Service Pack 2 ou ultérieur
= DirectX 9.0 ou version ultérieure = Port USB 2.0

= 100 Mo d'espace libre sur le disque dur = Lecteur de CD-Rom (2X ou plus)

= Windows Media Player 10,0 ou ultérieur « Résolution 1024 X 768 ou plus

= Sivous branchez le lecteur via un concentrateur USB, la connexion risque d'étre instable.
Veuillez brancher le lecteur directement sur l'ordinateur.

= Sivous branchez le lecteur sur I'ordinateur alors que la batterie est trop faible, le lecteur vérifie

automatiquement I'état de la batterie et se recharge durant plusieurs minutes avant de se con- 17
necter a l'ordinateur. —
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Chargement de votre fichier favori

Ajout de fichiers/dossiers dans Media Studio de Samsung

Media Studio vous permet de sélectionner et de répartir vos fichiers et dossiers en
prévision du transfert vers votre lecteur.

SAMSUNG ModioStudie _(wmess

=151~

B Forabie
[rPa e

B g
e [Feewere
e
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e
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e T

B erc B portable [YPKD X
Troe NS
= Feahcuss - Tha Best - 10. 'Whan | Look [
The fost - 15, Dont Trest L.,
14 There's Gotza e More To Lfe g3

3 | B Add Folder
i — 1

B A Foldor | Add File

b Add File
=

&
2698515 5 Nemolder

Veuillez vous reporter a la section Aide pour obtenir plus d'informations sur
I'utilisation de Media Studio.

= Cliquez sur <MENU> (MENU) O <Help> (Aide) O <Help> (Aide) dans le menu situé en haut du

programme Media Studio ou appuyez sur le bouton F1 de votre clavier durant la lecture




= Branchez le lecteur sur l'ordinateur.

= Media Studio doit étre installé sur 'ordinateur.

Media Studio démarre automatiquement lorsque vous branchez le lecteur sur

votre ordinateur.

= Sile programme ne démarre pas automatiquement, double-cliquez sur l'icone 2 Media Studio

située sur le bureau.

2 Cliquez sur I'icéne associée au fichier de votre choix située a gauche.

. Choisissez le type de fichier que vous souhaitez transférer en cliquant sur I'un de ces icones.
[ & représente un fichier musical et | @ représente une photo.

= Cliquez sur l'icone = pour afficher la liste ETC. La liste ETC comprend d'autres types de fichiers

(ex. : texte, xov, etc) que les fichiers musicaux, photo et vidéo.

| Pour ajouter des fichiers

3 Cliquez sur <Add Folder> (Ajouter un fichier) au bas
de I’écran de Media Studio.

» La fenétre Open Folder (Fichier ouvert) apparait.
4 Sélectionnez les dossiers que vous souhaitez

ajouter et cliquez sur <OK> (OK).

» Les fichiers du dossier sélectionné sont ajoutés a la liste située
a gauche dans I'écran Media Studio (Media Studio).

| Pour ajouter des dossiers

Open Folder (@]

[Aincluding the subfolder

Dr{pacuments and Settings siiDeskiop

(L My Documents
&3 My Computer
& 33 Floppy (A2
o Local Disk (C1)
5 < eng (0
(51122 Documents and Settings
53 Al Users

3 Cliquez sur <Add File> (Ajouter un fichier) au
bas de I’écran de Media Studio.

» La fenétre Open (Ouvert) apparait.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).

» Les fichiers sélectionnés sont ajoutés a la liste située a gauche
dans I'écran Media Studio (Media Studio).

o
L
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Chargement de votre fichier favori

Transfert de fichiers vers le lecteur avec Media Studio de Samsung

Exécutez les étapes suivantes pour transférer les fichiers depuis votre ordinateur
vers le lecteur.

SAMSUNG Medusiudie (wnes
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= La technologie de reconnaissance musicale et les données relatives sont fournies par
REMARQLE Gracenote et Gracenote CDDB® Music Recognition Service®".
= CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo
et le logotype Gracenote CDDB et le logo “Powered by Gracenote CDDB” sont des
marques déposées de Gracenote. Music Recognition Service et MRS sont des marques de
service de Gracenote.




W21-1- b = Branchez le lecteur sur l'ordinateur.
» Media Studio doit étre installé sur l'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur votre
ordinateur.

= Sile programme ne démarre pas automatiquement, double-cliquez sur l'icone £ Media Studio
située sur le bureau.

2 Cliquez sur l'icone associée au fichier de votre choix située & gauche.

. Choisissez le type de fichier que vous souhaitez transférer en cliquant sur I'un de ces icones.
| & représente un fichier musical et | @ représente une photo.

= Cliquez sur l'icone [ere) pour afficher la liste ETC. La liste ETC comprend d'autres types de fichiers
(ex. : texte, xov, etc) que les fichiers musicaux, photo et vidéo.

3 Sélectionnez le fichier a transférer sur la liste de gauche.

4 Cliquez sur 'icone & .

= Les fichiers sélectionnés sont transférés vers le lecteur.

= Ne débranchez pas la fiche USB durant le transfert sous peine d'endommager le lecteur ou
ATTENTION l'ordinateur.

= Lors du transfert d'un fichier photo vers le lecteur a I'aide de <Media Studio> (Media Studio), le
wepgE  fichier est converti automatiquement au format JPG avant le transfert. La taille du fichier est
également réglée automatiquement.

= Un fichier photo transféré vers le lecteur sans <Media Studio> (Media Studio) peut étre différent
de la source lors de son affichage sur I'écran du lecteur.

FRA
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Ecouter de la musique

Ecouter de la musique

A\l elendaliedt ) Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.

Ve

~

Music s« s

EXx. : lecture par artiste

1 Appuyez longuement sur le bouton [ '] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ < *] pour sélectionner

<Music> (Musique), puis appuyez sur le bouton [ O)].
= Le menu Music (Musique) apparait.

Menu Music (Musique)

<Now Playing> (En lecture) : permet d'afficher le titre en
cours.

<Artists> (Artistes) : lecture par artiste

<Albums> (Albums) : lecture par album

<Tracks> (Pistes) : lecture en ordre numérique ou alphabétique
<Genres> (Genres) : lecture par genre

<Playlists> (Listes de lecture) : lecture par liste

3 Appuyez sur le bouton [ «~ =+ ] pour sélectionner

<Artists> (Artistes), puis appuyez sur le bouton [O)].

REMARQUE

Les fichiers musicaux compatibles avec le lecteur sont aux formats MP3 et WMA.

Les fichiers MP1 ou MP2 possédant uniquement une extension modifiée vers MP3 peuvent ne pas étre lus.
Un fichier sans étiquette ID3 (informations musicales) s'affiche comme [Unknown] (Inconnu).

Les fichiers avec étiquette ID3 sont automatiquement répartis sur votre lecteur en fonction des
groupes Artists (Artistes) Albums (Albums) etc.

Une étiquette ID3 est la partie cachée de tout fichier musical et elle sert au classement.




Music

® Now Playing

FRA

4 Appuyez sur le bouton [ «~ =] pour
sélectionner un artiste, puis appuyez sur le

bouton [D)].

= Les albums de l'artiste apparaissent.

5 Appuyez sur le bouton [ «~ = | pour
sélectionner un album, puis appuyez sur le

bouton [(D)].

=« Les fichiers musicaux de I'album sélectionné
apparaissent.

6 Appuyez sur le bouton [ «~ =] pour
sélectionner un fichier musical, puis appuyez
sur le bouton [ ].
= La lecture de la musique démarre.

23
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Ecouter de la musique

Ecouter de la musique (suite)

| Mode Pause (Pause)

1 Appuyez sur le bouton [()] en cours de lecture.
» La lecture de la musique est interrompue.

2 Appuyez de nouveau sur le bouton [()].

= La lecture reprend a I'endroit otl vous l'avez suspendue.

= L'appareil s'éteint automatiquement lorsque aucun des boutons n'est actionné pendant une durée
REVARQLE prédéfinie (par défaut : 1 minute) en mode Pause (Pause). »Page 42

| Pour effectuer une recherche a l'intérieur d'une plage

1 Appuyez longuement sur le bouton[ < ] en cours de lecture de la piste
sélectionnée.

= Ces boutons permettent d'effectuer la recherche vers le début ou la fin de la plage.

2 Relachez le bouton dés que vous souhaitez reprendre la lecture.
= La lecture commence dés que vous relachez le bouton.



| Lecture de la plage en cours & partir du début.

Appuyez sur le bouton [ < ] aprés 3 secondes de lecture.
= La plage en cours est lue a partir du début.

| Lecture de la plage précédente/suivante

Appuyez sur le bouton [ < ] avant 3 secondes de lecture.
» La lecture de la plage précédente démarre.
Appuyez sur le bouton [ = ].

= La lecture de la plage suivante démarre.

= Pendant la lecture de fichiers VBR, la piste précédente peut ne pas étre lue méme si vous appuyez
ATTENTION sur le bouton [ < ] au cours des 3 premiéres secondes de lecture.

25
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Ecouter de la musique

Créer une liste de lecture avec Media Studio de Samsung

Une Liste de lecture est une liste de vos pieces musicales préférées.
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Cliquez sur le bouton <My Album> (Mon album) au haut de Media Studio.
» La fenétre <My Album> (Mon album) apparait.

2 Cliquez sur le bouton <New Album> (Nouvel album) au bas de I’écran.
= La fenétre Creation (Création) apparait.

3 Tapez le titre de I'album et cliquez sur <OK>,

= Un nouvel album (liste de lecture) est créé et enregistré dans la section My Album (Mon album)
de Media Studio.



| Transfert de fichiers musicaux sur une liste de lecture

1

4
5

Cliquez sur le bouton <My PC> (Mon ordinateur)
au haut de Media Studio.

» La fenétre <My PC> (Mon ordinateur) apparait.

FRA

2 Cliquez sur le bouton <My Album> (Mon

album) dans le coin droit de la fenétre.
» La fenétre Album (Album) apparait.

3 Cliquez deux fois sur I'album souhaité dans la

fenétre de droite.

Sélectionnez les fichiers que vous souhaitez
transférer dans la fenétre <My PC> (Mon ordinateur).

Cliquez sur I'icdne |&» .

= Les fichiers sélectionnés sont ajoutés a I'album (liste
de lecture).

| Exporter une liste de lecture avec Media Studio

1

W N

Cliquez sur le bouton <My Album> (Mon album)
au haut de Media Studio.

» La fenétre <My Album> (Mon album) apparait.

Cliquez sur le bouton <Portable> (Portable)
dans le coin droit de la fenétre.

= La fenétre <Portable> (Portable) apparait.

Sélectionnez I'album souhaité sur la liste
<My Album> (Mon album).

Cliquez sur I'icone |&» .

= L'album sélectionné est transféré sur le lecteur et
enregistré dans <Music> (Musique) O <Playlists> 27
(Listes de lecture).
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Ecouter de la musique

Pour lire une liste de lecture

Avant de démarrer!

Reportez-vous aux pages 26 et 27 pour plus de détails sur la création et le trans-
fert de listes de lecture sur votre lecteur.

® Playlists

4

5

Appuyez longuement sur le bouton [ 2 ] pour vous déplacer
vers le menu principal.

Appuyez sur le bouton [ % *] pour sélectionner <Music>
(Musique), puis appuyez sur le bouton [O)].

= Le menu Music (Musique) apparait.

Appuyez sur le bouton [ «~ =] pour sélectionner <Playlists>

(Listes de lecture), puis appuyez sur le bouton [()].

= LalLes liste(s) de lecture s'affiche(nt).

= Si une liste de lecture n'est pas trouvée, le message <No File> (Aucun
fichier) s'affiche a I'écran.

Appuyez sur le bouton [ « =] pour sélectionner la listes de

lecture souhaitée, puis appuyez sur le bouton [(D].

= Les fichiers musicaux enregistrés dans la liste de lecture sélectionnée a
pparaissent.

Appuyez sur le bouton [ « =] pour sélectionner un fichier

musical, puis appuyez sur le bouton [()].

« La lecture du fichier musical démarre.



Ecouter de la musique

Utilisation du menu option de musique

| Pour sélectionner un effet sonore

Vous pouvez sélectionner des effets sonores variés ; ils vous permettent de
rehausser la musique que vous écoutez.

FRA

xon. Normal 1 Appuyez sur le bouton [ 8] en cours de lecture.
= Le menu des options de musique apparait.

2 Appuyez sur le bouton [ « = ] pour sélectionner <Sound
Effect> (Effets Sonores), puis appuyez sur le bouton [()].
= Le menu des effets sonores apparait.

Sound Effect

3 Appuyez sur le bouton [ « =] pour sélectionner I'effet
sonore souhaité, puis appuyez sur le bouton [ ].
= Vous pouvez sélectionner soit <Normal> (Normal) <Vocal> (Voix) <Bass Boost>
(Ampli. basses) <3D Sound> (Son 3D) ou <Concert Hall> (Salle concert).

| Pour sélectionner I’égaliseur graphique EQ

son. Normal fi] 1 Appuyez sur le bouton [ @] en cours de lecture.
= Le menu des options de musique apparait.

2 Appuyez sur le bouton [ «~ ] pour sélectionner <Graphic
EQ> (EQ Graphique), puis appuyez sur le bouton [)].
= Le menu de I'égaliseur graphique apparait.

Graphic EQ

3 Appuyez sur le bouton [ «~ =+ ] pour sélectionner <On> (Activé)
ou <Off> (Désactivé), puis appuyez sur le bouton [()].

= <On> (Activé) : I'égaliseur graphique s'affiche a I'écran.
= <Off> (Désactivé) : I'égaliseur graphique ne s'affiche pas a I'écran.
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Ecouter de la musique

Utilisation du menu option de musique (suite)

| Pour sélectionner le Mode lecture

~on. Normal Appuyez sur le bouton [ @] en cours de lecture.
= Le menu des options de musique apparait.
Appuyez sur le bouton [ «~ =+ ] pour sélectionner <Play Mode>

(Mode lecture), puis appuyez sur le bouton [()].
« Le menu du Mode lecture apparait.

Play Mode

Appuyez sur le bouton [ «~ =+ ] pour sélectionner le mode
souhaité, puis appuyez sur le bouton [D].

» Vous pouvez sélectionner <Normal> (Normal) <Repeat One> (Répéter
une fois) <Repeat> (Répéter) ou <Shuffle> (Aléatoire).

<Normal> (Normal) : lecture ponctuelle et dans I'ordre de toutes les pistes.
<Repeat One> (Répéter une fois) : répétition ponctuelle d’un fichier.
<Repeat> (Répéter) : répétition de tous les fichiers (lecture en boucle).
<Shuffle> (Aléatoire) : lecture aléatoire des fichiers.



Affichage de I'image

Affichage de I'image

AVERIE e db Y Reportez-vous aux pages 20 et 21 pour le transfert des photos sur votre lecteur.

Ve

&

~

++ Photo «

”
= Vous pouvez voir la

REMARQUE

vignette d'information de la
photo sur la liste.

Les fichiers ne contenant
pas d'information affichent
plutot [§] .

1 Appuyez longuement sur le bouton [ 2 ] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ < *] pour
sélectionner <Photo>, puis appuyez sur le
bouton [)].

= Laliste de photos apparait.

3 Appuyez sur le bouton [ «~ = < ] pour
sélectionner le fichier photo souhaité,
puis appuyez sur le bouton [D)].

= Le fichier sélectionné apparait.
= L'affichage des images de grande taille nécessite
plus de temps.

| Affichage du diaporama

Vous pouvez visionner vos fichiers photo en
diaporama.

Appuyez sur le bouton [()] en mode de
visionnement de photo.
= Le diaporama démarre.

|Z| Appuyez sur le bouton [(0)] pour arréter le
diaporama.

| Pour visionner la photo précédente/suivante

Appuyez sur le bouton [ % *].
= La photo précédente ou suivante s'affiche a I'écran.

FRA
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Affichage de I'image

Utilisation du menu option de photo

| Pour écouter la musique en regardant vos photos

Vous pouvez écouter la derniére piece musicale tout en regardant vos photos.

Add to Screen S..

1
2

Appuyez sur le bouton [ @ ] en regardant la photo.
= Le menu des options de photos apparait.

Appuyez sur le bouton [ ()] pour sélectionner <Background
Music On> ou <Background Music Off>.

= <Background Music On> (Musique d’atmosphére activée) : permet
d’écouter la derniere piece musicale tout en regardant vos photos.

» <Background Music Off> (Musique d’atmosphere désactivée) : aucune
musique d’atmosphere en regardant une photo.

| Pour ajouter une photo sur la liste des économiseurs d’écran

Background Mu..

1

3

Sélectionnez un fichier photo que vous souhaitez ajouter sur la
liste des économiseurs d’écran.

Appuyez sur le bouton [ 8 ] en regardant la photo.

= Le menu des options de photos apparait.

Appuyez sur le bouton [ «~ =] pour sélectionne <Add to
Screen Saver> (Ajouter a écono. écran), puis appuyez sur le
bouton [D)].

= Le fichier photo sélectionné est ajouté & la liste des économiseurs
d'écran.

» Sélectionnez <Photo> (Photo) depuis <Settings> (Réglages) — <Display> — (Afficher) — <Screen Saver>
RENBROLE (Economiseur d'écran) et la photo sélectionnée s'affiche comme économiseur d'écran. » page 41

= Sivous sélectionnez <Default Set> (Réglages par défaut), I'économiseur d'écran est initialisé sur
<Analog Clock> (Horloge analogique).




Ecouter la radio FM

Ecouter la radio FM

AVEneedspkiedh ) Branchez les écouteurs, puis allumez le lecteur et vérifiez le bloc-piles.

+« FMRadio, »

1 Appuyez longuement sur le bouton [ ] pour
vous déplacer vers le menu principal.

2 Appuyez sur le bouton [ < *] pour
sélectionner <FM Radio> (Radio FM), puis
appuyez sur le bouton [O)].
= La réception de la radio FM est activée.

1 | Pour utiliser la fonction Mute (Muet)

Appuyez sur le bouton [(0)] lorsque vous écoutez
la radio FM.

= Le son est désactivé.

2 » Appuyez & nouveau sur le bouton [ © ] pour réactiver le son.

J

ATTENTION

= Branchez toujours vos écouteurs au lecteur lorsque vous recherchez ou réglez les fréquences.
Les écouteurs sont utilisés comme antennes de réception des ondes FM

33
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Ecouter la radio FM

Ecouter la radio FM (suite)

| Pour basculer vers le mode manuel

Sélectionnez ce mode si vous souhaitez effectuer une recherche manuelle d’'une
fréquence a la fois sur la bande FM.

(IS SO an 1 Appuyez sur le bouton [ @ ] en <Preset Mode> (Mode
présélection).

® Go to Manual .. , .
2 Appuyez sur le bouton [« = ] pour sélectionne <Go to Manual

Mode> (Aller au mode manuel), puis appuyez sur le bouton [O)].
» <Manual Mode> (Mode manuel) s'affiche.

| Pour basculer vers le Mode présélection

Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos
présélections FM une a la fois.

e e 1 Appuyez sur le bouton [ @] en <Manual Mode> (Mode manuel).

91 .1z 2 Appuyez sur le bouton [ « ] pour sélectionne <Go to Preset
Go to Preset .. Mode> (Aller au Mode Présél.), puis appuyez sur le bouton [)].

= <Preset Mode> (Mode présélection) s'affiche.

Appuyez sur le bouton [ < *] pour sélectionner la fréquence

présélectionnée.

= Des que <Preset Mode> (Mode présélection) s'affiche, vous pouvez
sélectionner une fréquence radio et I'écouter.

= Siaucune fréquence n'est présélectionnée, le message <Preset list does not exist.> (Liste présélection
inexistante) s'affiche et le lecteur ne bascule pas en <Preset Mode> (Mode présélection).
= Sivous sélectionnez <Default Set> (Réglages par défaut), les listes des préréglages sont supprimées.
= Sivous sélectionnez <Preset List> (Liste présélection) dans le menu des options FM, vous pouvez voir
les fréquences présélectionnées.
= Reportez-vous aux pages 36 et 37 pour plus de détails concernant le préréglage.

REMARQUE




| Pour rechercher automatiquement les fréquences

Manual Mode

Appuyez longuement sur le bouton [ < *] en mode
<Manual Mode> (Mode manuel).

= La fréquence la plus proche du point ol le bouton est relaché est
recherchée.

| Pour rechercher manuellement les fréquences

LICCLEED "' Appuyez sur le bouton [ % *] en <Manual Mode> (Mode manuel).

91 1 . = Change de fréquence a chaque nouvelle pression du bouton.
. 4

<)
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Ecouter la radio FM

Rég | ag e d ! u n e fréq u en C e |\'/aodl;§ lg(r?/lll,vez prérégler jusqu’a 30 fréquences

| Pour régler automatiquement les fréquences

Manual Mode {m

91 1 MHz

1 Appuyez sur le bouton [ @ ] en mode FM Radio.

2 Appuyez sur le bouton [ « =+ ] pour sélectionne <Auto Preset>
(Présélection auto.), puis appuyez sur le bouton [(O].
Auto Preset = La fenétre Auto Preset (Présélection auto.) s'ouvre.

3 Appuyez sur le bouton [ % *] pour sélectionne <Yes> (Oui),
puis appuyez sur le bouton [O)].
= Les fréquences sont présélectionnées automatiquement jusqu'a 30.

Q = Pour régler a nouveau la fonction <Auto Preset> (Préréglage automatique) apres la
REMBRLE configuration du préréglage, les fréquences existantes sont toutes supprimées et vous pouvez
alors procéder a une opération de réinitialisation depuis le début.

| Pour annuler une opération pendant le réglage

Appuyez sur le bouton [ % *] pour annuler la balayage automatique.
= Le préréglage automatique est annulé et les fréquences réglées jusque-la sont enregistrées.



FRA

| Pour régler manuellement les fréquences

Manual Mode 1 Appuyez légérement sur [ % * ] pour sélectionner la
fréquence souhaitée dans <Manual Mode> (Mode manuel).

91-1MHZ 2

Appuyez sur le bouton [ 8 ].
SR 3 Appuyez sur le bouton [ « = ] pour sélectionner <Add Preset>

(Ajouter présélection), puis appuyez sur le bouton [ ].

= La fréguence sélectionnée s'ajoute sur la Liste présélection. Un maximum de
30 numéros présélectionnés s'ajoute sur la liste en classement séquentiel.

Pour définir un numéro préréglé pour les autres fréquences,
suivez les étapes 1 a 3 ci-dessus.

= Sivous tentez d'ajouter une fréquence déja existante sur la Liste présélections, <This preset already

REAAROLE exists.> (Cette présélection existe déja) s'affiche et elle n'est pas ajoutée.

| Pour rechercher les fréguences en mode Preset (Prereglage)

RESStho “|  Appuyez sur le bouton [ @] en <Preset Mode> (Mode présélection).

91 1 MH = Le numéro présélectionné est sélectionné ; vous pouvez alors écouter la
. z

< 1A e fréquence radio attribuée a ce numéro.

L <) »

= Sivous souhaitez vérifier la Liste présélections en <Preset Mode> (Mode présélection), appuyez sur
REARQLE le bouton [ © ] pour sélectionner <Preset List> (Liste présélections) et appuyez sur le bouton [O] 37
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Ecouter la radio FM

Pour supprimer les préeréglages

Delete Preset
® 89.1MHz

Appuyez sur le bouton [ @] en <Preset Mode> (Mode
présélection).

Appuyez sur le bouton [ « =+ ] pour sélectionne <Delete
Preset> (Supprimer Présél.), puis appuyez sur le bouton [)].
» La fréquence présélectionnée s'affiche.

Appuyez sur le bouton [ «~ = ] pour sélectionner la fréquence
présélectionnée & supprimer, puis appuyez sur le bouton [(O)].
= La fenétre de confirmation apparait.

Appuyez sur le bouton [ % * ] pour sélectionner <Yes> (Oui),
puis appuyez sur le bouton [ ].
= Le numéro présélectionné sélectionné est supprimé.

Pour sélectionner et supprimer des numéros présélectionnés,
suivez les étapes 1 a 4 ci-dessus.



Ecouter la radio FM

Réglage de laradio FM

| Pour régler la Sensibilité FM

FRA

Manual Mode

91 1 MHz

1 Appuyez sur le bouton [ @ ] en mode FM Radio.

2 Appuyez sur le bouton [ «~ =] pour sélectionne <FM Sensitivity>
(Sensibilité FM), puis appuyez sur le bouton [ )]
® FM Sensitivity « Le menu FM Sensitivity (Sensibilité FM) apparait.

3 Appuyez sur le bouton [ «~ =] pour sélectionner la sensibilité,
puis appuyez sur le bouton [O)].

= Vous pouvez choisir entre <High> (Elevée), <Middle> (Moyenne) ou
<Low> (Basse).

= Plus la sensibilité est élevée, plus vous pouvez capter de fréquences.
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Réglages

Configuration de l'affichage it o e

1 Appuyez longuement sur le bouton [ ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ % *] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [D)].
-+ Settings = Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ « =] pour sélectionner <Display>
(Afficheur), puis appuyez sur le bouton [()].
= Le menu Display (Afficheur) apparait.

Settings

® Display

4 Utilisez les boutons [« =] et [0 ] pour régler les fonctions
souhaitées.

Fonctions des boutons pour la configuration

REIRQE ™ Appuyez sur le bouton [« =+ ] pour défiler sur la liste.
= Appuyez sur le bouton [ ©)] pour sélectionner et confirmer vos réglages.
= Appuyez sur le bouton [ ] pour revenir a I'écran précédent.




= <Screen Saver> (Economiseur d’écran) : permet d'utiliser une image comme économiseur
d'écran. Choisissez-en une depuis <Analog Clock> (Horloge analogique), <Anim. 1>, <Anim. 2>,
<Anim. 3>, et <Photo> puis réglez la période d'attente. <Photo> est celle que vous avez choisie
comme économiseur d'écran dans <Add to Screen Saver> (Ajouter a écono. écran). » page 32 <
Vous pouvez choisir entre <15 sec>, <30 sec>, <1 min>, <3 min>, <5 min>, et <Off> (Désactivé). o
Si aucun nombre n'est entré pour la sélection de la période, le systéme bascule l'image de
I'économiseur d'écran.

= <Display Off> (Afficheur désactivé) : si aucun nombre n'est entré pour la sélection de la
période, I'écran s'éteint automatiquement. Vous pouvez choisir entre <15 sec>, <30 sec>,
<1 min>, <3 min>, <5 min>, et <Always On> (Toujours activeé).
Lorsque I'écran d'affichage s'éteint, appuyez |égérement sur n‘importe quel bouton pour l'allumer
a nouveau.

églage de I’économiseur d’éc

1 Appuyez sur le bouton [« =] pour sélectionner <Screen Saver>
(Economiseur d'écran), puis appuyez sur le bouton [()].

= Le menu des économiseurs d'écran apparait.

2 Appuyez sur le bouton [ «~ =+ ] pour sélectionner I'image
15sec d’économiseur d’écran souhaitée, puis appuyez sur le bouton [ *].

3 Appuyez sur le bouton [ «~ =] pour sélectionner une période
d’attente, puis appuyez sur le bouton [ ].

= La fenétre de confirmation apparait.

4 Appuyez sur le bouton [ % * ] pour sélectionner <Yes> (Oui),
puis appuyez sur le bouton [)].

= Les réglages de I'économiseur d'écran sont complétés.
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Réglages
A ! Vous pouvez régler les fonctions Sleep Timer (Minuteur d'arrét)
Reg | ag e d e I h eu re et Auto Power Off (Arrét automatique) en plus de I'heure
actuelle.

Setings (W 1 Appuyez longuement sur le bouton [ ] pour vous déplacer

vers le menu principal.

® Time

2 Appuyez sur le bouton [ % *] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [)].
= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ « =] pour sélectionner <Time>
(Heure), puis appuyez sur le bouton [)].
= Le menu Time (Heure) apparait.

4 Utilisez les boutons [ « =] et [(O)] pour régler les fonctions
souhaitées.

» <Sleep Timer> (Minuteur de mise en veille) : permet d'éteindre
automatiquement I'appareil apres I'écoulement de la durée présélectionnée.
Sélectionnez soit <Off> (Désactivé), <15 min >, <30 min>, <60 min>,

<90 min>, ou <120 min>.

<Auto Power Off> (Mise hors tension automatique) : permet d'éteindre
automatiquement I'appareil lorsque aucun bouton n'est actionné avant
I'écoulement de la durée présélectionnée en mode Pause (Pause).
Sélectionnez soit <15 sec>, <30 sec>, <1 min>, <3 min>, ou <5 min>.
<Time Set> (Réglage heure) : permet de régler I'heure actuelle.

» Page 43



Réglage de I'heure

amw 1 Appuyez sur le bouton [ «~ =] pour sélectionner <Time set>
(Réglage heure), puis appuyez sur le bouton [(O)].

2 Appuyez légérement sur [ <% * ] pour accéder a <AM/PM, Hour,
Minute> (AM/PM, Heure, Minute) et utilisez [ +~ =] pour régler
I'heure.

3 Appuyez sur le bouton le bouton [)].
= La fenétre de confirmation apparait.

4 Appuyez sur le bouton [ < *] pour sélectionner <Yes> (Oui),
puis appuyez sur le bouton [O)].
= Le réglage de I'heure est enregistré.

FRA
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Réglages

CO nfl g u ra.t | O n d e Ia. | an g u e Vous pouvez définir la langue du menu.

Settings

W 1 Appuyez longuement sur le bouton [ 2 ] pour vous déplacer
vers le menu principal.

2 Appuyez sur le bouton [ % *] pour sélectionner <Settings>
(Réglages), puis appuyez sur le bouton [(D].
» Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ «~ =] pour sélectionner <Language>
(Langue), puis appuyez sur le bouton [(D].

4 Utilisez [ = =] et [ ] pour sélectionner la langue du menu.

« Options disponibles : <English>, < =01 >, <Francais>, <Deutsch>,
<ltaliano>, < BA3E >, < EtEHX >, < HHPX >, <Espafiol>, < Pycckuii >,
<Magyar>, <Nederlands>, <Polski>, <Portugués>, et <Svenska>.

= Les langues prises en charge peuvent étre modifiées ou ajoutées.
REMARQUE
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Réglages

CO nfl g u ratl on d u Systém e Permet de régler les derniéres options de

mémorisation et du bip sonore.

1 Appuyez longuement sur le bouton [ '] pour vous déplacer

: e <
ey vers le menu principal. &
Time 2
LEEETD Appuyez sur le bouton [ < *] pour sélectionner <Settings>

(Réglages), puis appuyez sur le bouton [(].
= Le menu Settings (Réglages) apparait.

3 Appuyez sur le bouton [ «
(Systeme), puis appuyez sur le bouton [()].
= Le menu System (Systeme) apparait.

4 Utilisez les boutons [ «
souhaitées.

=] pour sélectionner <System>

] et [] pour régler les fonctions

<Resume> (Reprise) : permet de définir le point de reprise de la lecture aprés avoir terminé I'écoute de
la musique. Sélectionner <On> (Activé) reprend la lecture depuis le dernier point d'arrét tandis que <Off>
(Désactivé) reprend la lecture depuis le début de la derniere écoute de la musique.

<Beep> (Bip sonore) : Permet aux boutons d'émettre un son lorsqu’ils sont activés. Options
disponibles : <On> (Activé) ou <Off> (Désactivé).

<Volume Limit> (Limite du volume sonore) : permet d'éviter les blessures aux oreilles en
réglant la limite du volume sonore lorsque vous utilisez les écouteurs. <On> (Activé) limite le
niveau du volume a 20 tandis que <Off> (Désactivé) le limite jusqu’a 30.

<FM Region> (Région FM) : permet de choisir votre région pour la radio FM. Sélectionnez
depuis <Korea/USA> (Corée/E.-U.), <Japan> (Japon) et <Other Countries> (Autres pays).

Bande de fréquences par région

- Corée/Etats-Unis: recherchez des fréquences FM comprises entre 87,5 MHz et 108,0 MHz pour les
lecteurs de 100 kHz.

- Japon : recherchez des fréquences FM comprises entre 76,0 MHz et 108 MHz pour les lecteurs de 100 kHz.

- Autres pays : recherchez des fréquences FM comprises entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

La région FM peut étre supprimée ou modifiée en fonction de la région cible du lecteur.

Si vous modifiez la région FM, les fréquences radio préalablement enregistrées seront supprimées.
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Réglages

Configuration du systéme (suite)

= <Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut.
» <Firmware Version> (Version de micrologiciel) : permet de consulter les informations relatives a
la version du micrologiciel, & la capacité de la mémoire et au numéro de fichier.

. Firmware Version (Version de micrologiciel) : indique la version de micrologiciel courante.

. Memory (Mémoire) : indique la capacité restante de mémoire. <Used> (Utilisée) indique la partie utilisée,
<Remain> (Restante) indique la capacité restante et <Total> (Totale) indique la capacité de mémoire
totale.

. Files (Fichiers) : <Music> (Musique) indique le nombre de fichiers musicaux, <Photo> (Photo) le nombre
de photos et <Total> (Total) le nombre total de fichiers.

Réglage par défaut

| Settngs (W) 1 Appuyez sur le bouton [« =] pour sélectionner <Default Set>
(Réglages par défaut), puis appuyez sur le bouton [O)].
« La fenétre de confirmation apparait.

® Default Set 2 Appuyez sur le bouton [ % *] pour sélectionner <Yes> (Oui),

puis appuyez sur le bouton [(D].

= <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.
= <No> (Non) : permet d'annuler les réglages par défaut.

= Sivous sélectionnez <Default Set> (Réglages par défaut), toutes les fonctions définies sont initialisées
REMRQE  SU les réglages par défaut.

= A propos de la mémoire intégrée
La taille de la mémoire intégrée réelle disponible est Iégérement inférieure a celle indiquée, car le
micrologiciel interne en utilise une partie.
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Dép an n ag e Si un dysfonctionnement survient, vérifiez les points suivants.

Probl

L'appareil ne s'allume
pas.

Les boutons ne
fonctionnent pas.

L'écran ne s'allume pas.

L'alimentation est coupée.

La durée de vie de la
batterie différe de celle
indiquée dans le
manuel.

Dysfonctionnement du
programme.

La connexion &

I'ordinateur est désactivée.

Si le probléme persiste, contactez le centre de dépannage Samsung le plus proche.

Points de contrdle et dépannage

L'appareil ne s'allume pas si la batterie est entierement déchargée.
Rechargez la batterie et remettez I'appareil sous tension.

Appuyez sur le trou de réinitialisation.

Vérifiez si l'interrupteur [HOLD ] est dirigé dans le sens de la fleche.

Vérifiez que vous avez appuyé sur le bouton adéquat, puis
essayez a nouveau. » Page 11

Appuyez sur le trou de réinitialisation

Si vous sélectionnez <Display Off> (Affich. désactivé) depuis <Settings> (Réglages)
- <Display> (Afficheur), I'écran ACL demeure éteint. Tapez sur n'importe quel
bouton pour allumer 'écran ACL ou vérifiez les réglages de l'afficheur. » page 41
II'se peut que les données affichées a 'écran ne soient pas visibles sous les
rayons directs du soleil.

Vérifiez I'état du bloc-piles.

L'alimentation se coupe automatiquement lorsque la batterie est
entierement déchargée. Rechargez la batterie.

Si <Auto Power Off> (Arrét automatique) est sélectionné dans <Settings>
(Réglages) -~ <Time> (Heure), 'alimentation est coupée en mode Pause
(Pause). Allumez le lecteur.

La durée du bloc-piles peut varier en fonction du mode sonore et
des réglages de I'écran.

La durée de vie du bloc-piles peut étre réduite si vous I'exposez a des
températures basses ou élevées pendant des périodes prolongées.

Vérifiez que la configuration requise de I'ordinateur a été
correctement établie.

Appuyez sur le menu Démarrer de la barre d'outil de votre ordinateur
pour lancer la mise a jour Windows. Redémarrez votre ordinateur et
rebranchez I'appareil.

FRA
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Dépannage (suite)

Probléme Points de contrdle et dépannage

La lecture est
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des
données manquent.

Affichage anormal de la
durée de lecture.

L'appareil est chaud.
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= Vérifiez que le fichier disponible a bien été enregistré dans le lecteur.
= Assurez-vous que le fichier musical n’est pas endommageé.
= Vérifiez que la puissance de la batterie est suffisante.

= Vérifiez que le cable USB est correctement branché.
Rebranchez-le au besoin.

= Assurez-vous qu'il reste de I'espace disponible sur la mémoire.

= Appuyez sur le trou de réinitialisation

Vérifiez que le cable USB n'a pas été débranché durant le transfert
du fichier ou des données. Si tel est le cas, les fichiers/données mais
également I'appareil risquent d'étre endommagés. Vous devez faire
preuve d'une extréme prudence a cet égard car Samsung ne saurait
en aucun cas étre tenu responsable de la perte des données.

Vérifiez que le fichier est au format VBR (débit binaire variable).

Les phases de chargement peuvent générer de la chaleur. Cela
n'a aucune incidence sur la durée de vie de I'appareil ou sur son
fonctionnement.



A r b O res C e n C e d eS m en u S Cette fonction vous permet de consulter

rapidement la structure du menu.

<
:
Music FM Radio Photo Settings
Display Time Language System
Screen saver Sleep Timer Resume
Display Off Auto Power Off Beep
Time Set Volume Limit
FM Region
Default Set
About
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Caractéristiques du produit

Nom du modele YP-K3
Alimentation 3,7V (Lithium polymere rechargeable)
Alimentation de la batterie intégrée 500mAh

Fichier Compatibilité

Music : MPEG1/2/2.5 3 couches (8 kbps a 320 kbps, 22 kHz a 48
kHz), WMA(48kbps a 192kbps, 22kHz a 48kHz)

Image : JPEG (ISO/IEC 10918-1/Annexe F — Mode de
fonctionnement séquentiel DCT)

Sortie des écouteurs

20 mW(France 5 mW/CH)(16 Q)

Bande de fréquences de la sortie

20 Hz & 20 KHz

Taux de bruit

88 dB avec filtre passe bas 20 kHz (& partir de 1 KHz, 0 dB)

Durée de lecture

25 heures de musique (fondé sur MP3 a 128 kbps, niveau de volume
a 15 en mode normal)

Plage de températures de fonctionnement

5a35°C

Boitier

Inoxydable, plastique

Poids

1.76 oz (500)

Dimensions (L x H x P)

1.73 X 3.78 X 0.27 inches (44 X 96 X 6.95 mm)

Fréquence FM

87,5~108,0MHz

Rapport signal FM 50dB
T.H.D. FM 1%
Sensibilité FM utile 38dBu

e Le contenu de ce manuel est susceptible d'étre modifié en vue d’étre amélioré sans

notification préalable.



Licence

L'unité qui se trouve avec ce manuel de I'utilisateur est fournie sous licence sous

certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée a une

utilisation privée non commerciale par I'utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue a un
produit ou processus qui n'est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniquement l'utilisation de ce produit pour encoder et/ou décoder
des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions

du produit qui ne sont pas conformes a la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Ce symbole sur le produit ou sa documentation indique

qu’il ne doit pas étre éliminé en fin de vie avec les autres

déchets ménagers. L'élimination incontrolée des déchets

pouvant porter préjudice a I'environnement ou a la santé

humaine, veuillez le séparer des autres types de / N\
déchets et le recycler de facon responsable.

Vous favoriserez ainsi la réutilisation durable des
ressources matérielles.

Les particuliers sont invités a contacter le distributeur
leur ayant vendu le produit ou a se renseigner aupres
de leur mairie pour savoir ou et comment ils peuvent
se débarrasser de ce produit afin qu'il soit recyclé en
respectant I'environnement.

Les entreprises sont invitées a contacter leurs \ _ /
fournisseurs et a consulter les conditions de leur

contrat de vente. Ce produit ne doit pas étre éliminé avec

les autres déchets commerciaux.
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.
Samsung Service Consommateurs
08 25 08 65 65 (€ 0,15/min)
www.samsung.com/fr
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